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ARDUINO _souno

SQUARE WAVE ‘

SINE WAVE(SOUND)



ARDUINO _speaker

Constant Name

NOTE_B2
NOTE_C3
NOTE_CS3
NOTE_D3
NOTE_DS3
NOTE_E3
NOTE_F3
NOTE_FS3
NOTE_G3
NOTE_GS3
NOTE_A3
NOTE_AS3
NOTE_B3
NOTE_C4
NOTE_CS4
NOTE_D4
NOTE_DS4
NOTE_E4
NOTE_F4
NOTE_FS4
NOTE_G4
NOTE_GS4
NOTE_A4
NOTE_AS4
NOTE_B4
NOTE_C5
NOTE_CS5
NOTE_D5
NOTE_DS5
NOTE_E5
NOTE_F5
NOTE_FS5
NOTE_G5

Frequency (Hz)

123
131
139
147
156
165
175
185
196
208
220
233
247
262
277
294
311
330
349
370
392
415
440
466
494
523
554
587
622
659
698
740
784

Constant Name

NOTE_GS5
NOTE_A5
NOTE_AS5
NOTE_B5
NOTE_Cé6
NOTE_CS6
NOTE_D6
NOTE_DS6
NOTE_E6
NOTE_Fo6
NOTE_FS6
NOTE_G6
NOTE_GS6
NOTE_A6
NOTE_AS6
NOTE_B6
NOTE_C7
NOTE_CS7
NOTE_D7
NOTE_DS7
NOTE_E7
NOTE_F7
NOTE_FS7
NOTE_G7
NOTE_GS7
NOTE_A7
NOTE_AS7
NOTE_B7
NOTE_CS8
NOTE_CS8
NOTE_DS8
NOTE_DS8

Frequency (Hz)
831
880
932
988
1047
1109
1175
1245
1319
1397
1480
1568
1661
1760
1865
1976
2093
2217
2349
2489
2637
2794
2960
3136
3322
3520
3729
3951
4186
4435
4699
4978



PROCESSING _ miNIM LIBRARY: LOAD SAMPLE

import ddf. minim.*;
Minim minim;
AudioSample kick;
void setup()
{
size(512, 200, P2D);
/] always start Minim before you do anything with it
minim = new Minim(this);
/] load BD.mp3 from the data folder with a 1024 sample buffer
/] kick = Minim.loadSample(“BD.mp3”);
/] load BD.mp3 from the data folder, with a 512 sample buffer
kick = minim.loadSample(“BD.mp3”, 2048);
}
void draw(){
background(0);
stroke(255);
// use the mix buffer to draw the waveforms.
// because these are MONO files, we could have used the left or
right buffers and got the same data
for (int i = 0; i < kick.bufferSize() - 1; i++)
{
line(i, 100 - kick.left.get(i)*50, i+1, 100 - kick left.get(i+1)*50);
}
}
void keyPressed()
{
if (key == K’ ) kick.trigger();
}
void stop()
{
/] always close Minim audio classes when you are done with them
kick.close();
minim.stop();
super.stop();
}
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FRITZING _custom pcB BoARD

The first step in designing a PCB layout is arranging the parts on the board.
There are some very important issues to consider here, because the location of parts on the board will have a great effect on how successful the routing
process will be.

Follow these guidelines:

- Place the parts with the most connections in the middle of the board.

- Notice that Arduino’s footprint should also be positioned on the board, just like other parts (new in version 3.0).

- Rotate and position parts, leaving enough space between them (don't forget their actual size!).

- If the board is too small, redefine its width and height in the Inspector or alternatively resize the board by dragging its corners. Learn how to design
a PCB with a custom shape.

- Don’t place parts too close to the edges of the board.

- To avoid short circuits, don’t place parts too close to the USB connector outline on the Arduino Shield.

- When designing stack shields, parts” heights should also be considered.

The following screenshot shows one out of many possible part arrangements for the given circuit:

Select O iterns
Select all Trace wires
| | Delete 10 items
| Select Wire

to add a bend [ Delete Wire




Auto-routing

After positioning all parts on the board, be aware that parts are not really connected to each other yet. The thin connecting lines that you see (Rat’s
Nest Layer) only act as a guideline. We would now want Fritzing to automatically generate the connection traces between parts. Click the Auto-route
function from the bottom menu bar.

If you notice that Fritzing is struggling trying to generate a connection, you can press the “Skip this Trace” button or “Cancel Auto-routing” in the bot-
tom menu while in process.




Hand-routing

Use any of the following methods to hand-route traces and jumpers:

The safest way is to right-click a Rat’s nest wire and choose “Create Trace from Selected Wire(s)” or “Create Jumper from Selected Wire(s)”. This will

avoid making any changes in the circuit that you built in Breadboard View.

Another way is to simply click a part’s connector, and drag to make a connection. A trace will be created. To create a jumper, just right-click on the
trace and choose “Create Jumper from Selected Wire(s)”. To avoid incorrect wiring, we strongly recommend you follow the Rat’s nest wire connections

while using this method.

Note that while clicking and holding on a connector, all equipotential connectors are highlighted (in yellow). This shows the whole set of connections
attached to this particular connection, and can really help to make hand-routing decisions. Once again, take good care not to cross wires!

Raise and Lower

Create Trace from Selected Wire(s)
Create Jumper from Selected Wire{s) .
Don't Autoroute This Trace

Delete
Add Bendpoint

'y
¥
1% FNAVIGATOR
e

Create a pimper wire from the selected wire

Guidelines for better routing

For both auto- and hand-routing, follow these
guidelines:

-Place the parts with the most connections in

the middle of the board.

-Try to get short connections by moving and
rotating parts.

-Use the highlighting of equipotential connectors
feature.

-Add bend points for tidy routing and so that
lines do not cross.

-Don't forget the traces can go under parts like
resistors.

-Use jumper wires instead of watching the auto-
route go crazy.



Export Options

Fritzing features a variety of export options. When you are happy with your PCB design, you can choose to export JPG, PNG, etchable PDF and even
Gerber files (for sending a professional PCB manufacturing service). The Bill of Materials option generates a list of all parts in the circuit.
From the menu bar choose File > Export > and the desired format.

-For DIY PCB production, use the Etchable PDF option which exports only the necessary design for etching.
-When exporting Gerber files, create a folder for the gerbers, and zip. it before sending to a manufacturer.

Open...
Open Recent Files
Open Example

Close Window

Save

Save As...

Save As Shareable...

to PDF...
to PostScript...
to SWG...
to PNC...
to JPG...

List of parts (Bill of Materials)

Etchable PDF...




FRITZING__custom pcB BOARD SHAPE

Fritzing lets you design your PCB in any size and any shape. When you start working on a new sketch, a default rectangle board is placed in the PCB
View. You can then define width and height in the Inspector or alternatively resize the board by dragging its corners.

To use boards with more complex shapes, create your board's shape with an external SVG editor (Inkscape, Illustrator etc.) and then import it to Fritz-
ing. Follow these steps:

1. Design an SVG with two sub-layers:
board layer with a path in any shape and size (NOTE: for gerber export, please use only polygons!). The shape should be filled green and with no
stroke.

A silkscreen layer with a copy of the path you've just done, this time with no fill and with white stroke (for Inkscape users: stroke = 8 mil). Make sure
the silkscreen layer is arranged at the top.

@[ oo
| Layers x | _';
® | || ] Layer2 od
- | v Ds:lk5creen (ol |

L bl e | D <Path> OB
[ || v [mooars om
= | E <Path= OB

b
.
L
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FRITZING _custom pcB BoARD

2. [llustrator Users: Align all elements to the center of the artwork
3. Illustrator Users: Use the crop tool and choose the preset “fit crop area to selected art”

SVG 1.0
SVG 1.1
SVG Tiny 1.1
SVG Tiny 1.1 +
SVC Basic 1.1
SVG Profiles B ol il "8 ¥

Custom Width: 4,04 om Height: 12,53 am X|11,27 cm ¥ 848 om

Fit Crop Area to Anboard = 3 [ | { | x| I vl I
Fit Crop Area to Ariwork bounds

Fit Crop Area to selected art

— Fonts - -
ance
—= Type: | svG 4 ( Cancel )
| Subsetting: | None (Use Systemn Fonts) 2

m xw\idesmgn > M ( More Options )
NTSC D1
NTSC D2 Widescreen | Images
PALDL/DV s .
PALDL/DV Widescreen Location: (@) Embed () Link
HOV/HOTV 720 4
m:m 720 [ Praserve lllustrator Editing Capabilities
DVICPRO HD 1080 o |
it i — Description
Cingon Half i }
Cineon Full 4 3 ‘v The exported file !las features and syntax compatible with the
Film (2K) VG Tiny 1.2 Specification. This profile is sultable for mobile
Fllm (4K) £ phones.
176 % 208 ) 1 Show SVG Code...
176 % 220 J
230 % 240
240 x 252 [ (ﬁ
240 x 266 | I Device Central...

240 % 270
240 % 320
352 % 416

VCA (640 x 480)
SVGA, (800 x B00)
XCA {1024 x 768)

Xl =@ NueEwne

6. Drag a plain PCB to the PCB View.
7. In the Inspector, select “import shape” from the shape drop down menu, navigate to the SVG file and press “Open”. Your custom PCB shape is ready

to use!



EagleCad

Here are some of the basic quick keys:

Press escape at any time to stop the current action and return to the schematic window
F7 to move a part

Alt+F7 to group a bunch together

F3 to delete a part

F4 to rename a part (change C7 to C2)

F5 to re-value a part (change 0.1uF to 10uF, etc)

F6 to smash a part (be able to move the name and value tags)

F9 to start a wire

Alt+F9 to add a label to a wire

NEVER change the grid size in the schematic editor. Leave it on 0.1inch steps and don’t use
the alternate 0.01 step. If you do, you won’t be able to hook wires to the pin tie points.

Info

Display

Move
Mirror
Group
Cut
Delete
Pinswap
Mame
Smash

Split

Wire
Circle
Rectangle
Bus

Junction

ERC

B b P -

8 X!
A B = BNESe 2 v

=

H+JBONNB

Q

o | 1z

Show

- Mark

Copy
Rotate
Change
Paste
Add
Gateswap
Value

Miter

| Invoke

Text
Arc
Polygon
Met
Label



Eaglecad_schemaﬁcs

Now let’s add the FT232RL part to our schematic. Close the library editor and go back to the Eagle Control Panel. Click on File->New->Project. Name
this new project ‘FT232-Breakout. Right click on the FT232-Breakout project and create a new Schematic:

Control Panel - EAGLE 4.15 Light
S e Cpiimm jginien o

File Wiew Options wWindow Help e B
B~ b FT232RL-BASIC
Mame D escription e enenel s . :
Libraies iy Do :._li_!!grhl Vim: e oo e o o I XL . Doy bt scus reomd. cbereg s o e b
: FRiotonera P I
Design Rules FEboneL e
User Language Programs User Language Programs FEEE FHARE
Scriptz EEtmim T
C4M Jobs {H:"f* i8]
= Projects I-l:"t'-'-w el
W & Fronhy Project EEmmaia 4T TO Soiemais Tiges iF
Close Project 4gpn ] UG LSAT 2 m i
= ] | EEFTTERL S50 o Ll > 'r- B Semall Sk Dl Pahiogs
Schematic FEFT2ERL PSR FIFT) L -
2 FEake] @ =
Rename Bioard L 2=t
I LI et o
Delete Library ERGRD_CisLEl -
Edit Description | ey [ Pabap  Oemrpi
——— ?—;Llob EE:.,LT Pp— L1 2R SRR DT A TEPTES sl e P
Use all ‘ ULP Elssers e ] =
. Elwammein_paryGir HOLENG
Usi none | Script Ebraam o o
| Text Ehsgastroe ek
- | EEFTH: (TRECTOR FEMALE i Tommle Cormpoien
FEFUT_ [OnnECT0R A E
Folder Chiviis
Project “f -y e
ERLASSEN_I5 P Lemsnm
ERE-da i Gamphacal LET 1 30l
EELcs _BarnLioHT_Pais

The schematic editor should open. Now go back to the Eagle Control Panel and expand the SparkFun Library:
You should see a long list of parts. Highlight the FT232RL-Basic part and in the right screen click on ADD. The schematic editor will pop up allowing
you to place the FT232RL.



Now add these other items to your schematic:

1 x FRAME-LETTER : This will add a nice frame to your schematic. Add all
parts inside this frame.

3 x CAP (Device name CAP0603) : 0.1uF/0.01uF 0603 capacitors
1 x CAP_POL (Device name CAP_POL1206) : 10uF tantalum capacitor
1 x INDUCTOR (Device name INDUCTORO0603) : Ferrite bead

4 x STAND-OFF( Device name STAND-OFF): This part will add a hole and

a keepout ring for a #4-40 screw. These can be used to raise your board up off a

surface or to mount your board to an enclosure.
USB (Device name USBPTH) : USB Type B through-hole connector

MO04 (Device name M04PTH) : Four pin 0.1” connector

GND (Device name GND) : Ground connections

VCC (Device name VCC) : Power connections




Now we just need to begin wiring nets. Arrange the pieces so that there is as little net overlaps as possible.
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To wire a pin (TXD) to a far point (the 4-pin connector for example), instead of sending a wire half way across the page, we use net names. The green
wire is not physically seen on the schematic, but Eagle knows to connect the two points on the layout because the two green wires have the same name.

Press F9 and click on pin 1 (TXD). Bring out the net a couple square widths and left click again to end the net. Press Alt+F9 to name the net. Click on
the wire you just created. You should see a net name (like N$5) appear and be floating. Anchor it to the wire and TX pin:

| usB |




I probably could have wired JP1 directly to the various pins but I wanted to demonstrate the net/name properties. This will also make it easier to label
the pins on the PCB. Speaking of which, if you have not already, click on the ‘Board’ button to open the PCB editor:

2 1 Schematic - D:\Global\Eagle
File Edit Draw \iew Tools Library

Ly EIIIEIFEI_
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EagleCad

PCB Layout

Before you do anything, turn on vector fonts! If you don’t, your silkscreen text will be off on every PCB you create:

Control Panel - EAGLE 4.15 Light

File ‘Wiew

Dplions

~£3
- 22|POD_CONNECTOR_MALE
~BRIRFIN0

~B2IPIE

- BDASSEN_IO_GPS

Window Help

Direckories. ..

Backup. . I

ECTOR_FEMALE

Dezcription
HWEB2EM

D300
[nductars
iIPod Female Conne

Jurnper
Lazzen ig

Pulldown menu
Ation toalbar
Parameter toolbar
Command buttans
[] Cammand tests
Misc

Blwaps vechar font
Lirnit ZDD%-ECUJI'

Mouse wheel zoom |1.2

User interface IZI
Controlz Layout

Background: (#) Black () Wwhite () Colored
Curzor; (& Smal () Large
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Help
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Make sure you're on a 0.1" grid by pressing F10. Then hit F7 and hold control while clicking near the origin. This will grab the frame corner and force
it onto the 0.1" grid. Make the bottom left corner sit at (0,0):

Do this for the other three corners bringing them in to make a 1.5x1.0” square board size.




Now go to town bringing the components into the board area. Keep in mind the gold color un-routed ‘air’ wires. The less twisted you make these by
creatively arranging your components, the easier the trace routing will be.

Remember:
Press F7 to move a component
Right click to rotate

Hold control to grab a component at its origin

SBO S AN

Scroll wheel to zoom in/out

¢OBON ANE

H

Hit the Ratsnest button from time to time to recalculate the air wires.




Here are the components arranged in a basic configuration. Another beef I have with Eagle is the default colors for the various layers make it impos-
sible to see what is going to be printed on the silkscreen layer. Let’s change the ‘tPlace’ layer to pure white and change the ‘tDocu’ layer to lemon yellow.

Click on the ‘Display’ button, scroll down to layer 51 and double click on the gray box next to ‘tDocu’:

®| Display

Lavers:

| Mr Mame
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43 wRestnct
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Document
Reference
tDocu
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I MNew J [ LChange ] [ Del
| a1 [ Mo
[ (] 4 l [ Canice

Then click on the gray 'Color' box and change it to something interesting like lemon yellow, then click ok. Anything you do on this layer will now be
yellow. Do the same for layer 21 'tPlace’.

The yellow part of the USB connector is only there to indicate that the connector sticks over the edge that far. Only the white part of the USB connec-
tor footprint will actually show up on the silkscreen print on our PCB. Anything in light gray (tNames and tValues layers) will not print on the silk-
screen layer. They're just there for your own reference. We can of course change how the various layers are processed (and include the value and name
layers on the silkscreen) but this can cause a lot of squeezing and hassle. It’s up to you and your design but we will leave the part indicators and values
out of this layout.



I like to use 4-40 screws and 0.25” diameter plastic standofts on everything. These 4-40 screws need a 0.13” diameter hole and the standoffs have a
0.25” outside diameter that we will need to take into account. If you have not already done so, add four of the ‘Stand-Oft” components to the schematic
(and therefore PCB). This component was created to couple the 0.13” drill with a keepout ring. This keepout ring helps show were the screw head will
fall. If you fail to take this keepout layer into account, the screw will go through the hole, but the screw head may run into or short components.

Throw four standoff holes around the corners of your board.




A ‘C2’ label is handy when you're populating a board or when you’re troubleshooting a complex circuit, but on a day to day basis, you probably won't
need to know where C2 is. On the other hand, the TX and RX pins will probably be used every time you use the board! You really should label any-
thing that will be connected to the outside world. To add a text label to a pin, click on the “Text’ button:
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A window will pop up asking you what text you would like to add. Type “TX’ and

layer. Be sure that you add text on the tPlace layer.
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Make sure you add your labels to the 'tPlace’ layer!



To change the font size, click on the Wrench ('Change’ button), select 'Size', then 0.05. Now click
on each text that you want to change the size on.
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Above is the completed board ready for trace routing.

we're not concerned about trace impedance or high speed signals, an auto-router is
a great way to whip up protos. Spend your time innovating, not routing mundane
traces.

X 0] Many people swear up and down that an auto-router is a bad idea. It may be, but if
$park{un.com =~
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FT232RL Breakout v1.0

* Autorouter Setup To auto-route the board, click on the
‘Auto button. The defaults are all fine
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